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How to make a Gantt chart in Excel 2010, 2013 and Excel 2016
by Svetlana Cheusheva Excel, Excel charts, Excel tips 193 Comments

If you were asked to name three key components of Microsoft Excel, what would they be? Most
likely, spreadsheets to input data, formulas to perform calculations and charts to create graphical
representations of various data types.

I believe, every Excel user knows what a chart is and how to create it. However, one graph type
remains opaque to many - the Gantt chart. This short tutorial will explain the key features of the
Gantt diagram, show how to make a simple Gantt chart in Excel, where to download advanced
Gantt chart templates and how to use the online Project Management Gantt Chart creator.

What is the Gantt diagram?

How to make a Gantt chart in Excel

Excel Gantt chart templates

What is a Gantt chart?
The Gantt chart bears a name of Henry Gantt, American mechanical engineer and management
consultant who invented this chart as early as in 1910s. A Gantt diagram in Excel represents
projects or tasks in the form of cascading horizontal bar charts. A Gantt chart illustrates the
breakdown structure of the project by showing the start and �nish dates as well as various
relationships between project activities, and in this way helps you track the tasks against their
scheduled time or prede�ned milestones. 

How to make Gantt chart in Excel 2016, 2013 and
2010
Regrettably, Microsoft Excel does not have a built-in Gantt chart template as an option. However,
you can quickly create a Gantt chart in Excel by using the bar graph functionality and a bit of
formatting.

Please follow the below steps closely and you will make a simple Gantt chart in under 3 minutes.
We will be using Excel 2010 for this Gantt chart example, but you can simulate Gantt diagrams in
Excel 2016 and Excel 2013 exactly in the same way.

1. Create a project table
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You start by entering your project's data in an Excel spreadsheet. List each task is a separate row
and structure your project plan by including the Start date, End date and Duration, i.e. the number
of days required to complete the tasks.

Tip. Only the Start date and Duration columns are really necessary for creating an Excel Gantt
chart. However, if you enter the End Dates too, you can use a simple formula to calculate
Duration, as you can see in the screenshot below. 

2. Make a standard Excel Bar chart based on Start date
You begin making your Gantt chart in Excel by setting up a usual Stacked Bar chart.

Select a range of your Start Dates with the column header, it's B1:B11 in our case. Be sure to
select only the cells with data, and not the entire column.

Switch to the Insert tab > Charts group and click Bar.

Under the 2-D Bar section, click Stacked Bar.
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As a result, you will have the following Stacked bar added to your worksheet: 

Note. Some other Gantt Chart tutorials you can �nd on the web recommend creating an
empty bar chart �rst and then populating it with data as explained in the next step. But I think
the above approach is better because Microsoft Excel will add one data series to the chart
automatically, and in this way save you some time.

Step 3. Add Duration data to the chart
Now you need to add one more series to your Excel Gantt chart-to-be.

Right-click anywhere within the chart area and choose Select Data from the context menu. 

The Select Data Source window will open. As you can see in the screenshot below, Start Date
is already added under Legend Entries (Series). And you need to add Duration there as well.

1.
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Click the Add button to select more data (Duration) you want to plot in the Gantt chart. 2.

The Edit Series window opens and you do the following:

In the Series name �eld, type "Duration" or any other name of your choosing. Alternatively,
you can place the mouse cursor into this �eld and click the column header in your
spreadsheet, the clicked header will be added as the Series name for the Gantt chart.

Click the range selection icon  next to the Series Values �eld.

3.

A small Edit Series window will open. Select your project Duration data by clicking on the �rst
Duration cell (D2 in our case) and dragging the mouse down to the last duration (D11). Make
sure you have not mistakenly included the header or any empty cell. 

4.

Click the Collapse Dialog icon to exit this small window. This will bring you back to the previous
Edit Series window with Series name and Series values �lled in, where you click OK. 

5.

Now you are back at the Select Data Source window with both Start Date and Duration added
under Legend Entries (Series). Simply click OK for the Duration data to be added to your Excel

6.



12/4/2017 How to make Gantt chart in Excel (step-by-step guidance and templates)

https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/ 5/21

Step 4. Add task descriptions to the Gantt chart
Now you need to replace the days on the left side of the chart with the list of tasks.

chart. 

The resulting bar chart should look similar to this: 

Right-click anywhere within the chart plot area (the area with blue and orange bars) and click
Select Data to bring up the Select Data Source window again.

1.

Make sure the Start Date is selected on the left pane and click the Edit button on the right
pane, under Horizontal (Category) Axis Labels. 

2.
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Step 5. Transform the bar graph into the Excel Gantt chart
What you have now is still a stacked bar chart. You have to add the proper formatting to make it
look more like a Gantt chart. Our goal is to remove the blue bars so that only the orange parts
representing the project's tasks will be visible. In technical terms, we won't really delete the blue
bars, but rather make them transparent and therefore invisible.

A small Axis Label window opens and you select your tasks in the same fashion as you selected
Durations in the previous step - click the range selection icon , then click on the �rst task in
your table and drag the mouse down to the last task. Remember, the column header should
not be included. When done, exit the window by clicking on the range selection icon again. 

3.

Click OK twice to close the open windows.4.

Remove the chart labels block by right-clicking it and selecting Delete from the context menu. 

At this point your Gantt chart should have task descriptions on the left side and look
something like this: 

5.

Ultimate Suite for Excel Professionals
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Click on any blue bar in your Gantt chart to select them all, right-click and choose Format
Data Series from the context menu. 

1.

The Format Data Series window will show up and you do the following:

Switch to the Fill tab and select No Fill.

Go to the Border Color tab and select No Line.

Note. You do not need to close the dialog because you will use it again in the next step.

2.

As you have probably noticed, the tasks on your Excel Gantt chart are listed in reverse order.
And now we are going to �x this.

Click on the list of tasks in the left-hand part of your Gantt chart to select them. This will display
the Format Axis dialog for you. Select the Categories in reverse order option under Axis

3.
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Step 6. Improve the design of your Excel Gantt chart
Though your Excel Gantt chart is beginning to take shape, you can add a few more �nishing
touches to make it really stylish.

Options and then click the Close button to save all the changes. 

The results of the changes you have just made are:

Your tasks are arranged in a proper order on a Gantt chart.

Date markers are moved from the bottom to the top of the graph.

Your Excel chart is starting to look like a normal Gantt chart, isn't it? For example, my Gantt
diagram looks like this now: 
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Remove the empty space on the left side of the Gantt chart.

As you remember, originally the starting date blue bars resided at the start of your Excel Gantt
diagram. Now you can remove that blank white space to bring your tasks a little closer to the
left vertical axis.

Right-click on the �rst Start Date in your data table, select Format Cells > General. Write
down the number that you see - this is a numeric representation of the date, in my case
41730. As you probably know, Excel stores dates as numbers based on the number of days
since 1-Jan-1900. Click Cancel because you don't actually want to make any changes here. 

Click on any date above the task bars in your Gantt chart. One click will select all the dates,
you right click them and choose Format Axis from the context menu. 

Under Axis Options, change Minimum to Fixed and type the number you recorded in the
previous step.

1.

Adjust the number of dates on your Gantt chart.

In the same Format Axis window that you used in the previous step, change Major unit and
Minor unit to Fixed too, and then add the numbers you want for the date intervals. Typically,
the shorter your project's timeframe is, the smaller numbers you use. For example, if you want
to show every other date, enter 2 in the Major unit. You can see my settings in the screenshot
below.

2.
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Note. In Excel 2013 and Excel 2016, there are no Auto and Fixed radio buttons, so you simply
type the number in the box.

Tip. You can play with di�erent settings until you get the result that works best for you.
Don't be afraid to do something wrong because you can always revert to the default
settings by switching back to Auto in Excel 2010 and 2007, or click Reset in Excel 2013 and
2016.

Remove excess white space between the bars.

Compacting the task bars will make your Gantt graph look even better.

Click any of the orange bars to get them all selected, right click and select Format Data
Series.

In the Format Data Series dialog, set Separated to 100% and Gap Width to 0% (or close to
0%).

3.
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And here is the result of our e�orts - a simple but nice-looking Excel Gantt chart: 

Remember, though your Excel chart simulates a Gantt diagram very closely, it still keeps the
main features of a standard Excel chart:

Your Excel Gantt chart will resize when you add or remove tasks.

You can change a Start date or Duration, the chart will re�ect the changes and adjust
automatically.

You can save your Excel Gantt chart as an image or convert to HTML and publish online.

Tips:

You can design your Excel Gant chart in di�erent ways by changing the �ll color, border
color, shadow and even applying the 3-D format. All these options are available in the
Format Data Series window (right-click the bars in the chart area and select Format Data

https://www.ablebits.com/office-addins-blog/2013/08/27/save-excel-chart-as-image/
https://www.ablebits.com/office-addins-blog/2014/03/21/convert-excel-html/
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Download this Gantt chart example.

Excel Gantt chart templates
As you see, it's not a big problem to build a simple Gantt chart in Excel. But what if you want a
more sophisticated Gantt diagram with percent-complete shading for each task and a vertical
Milestone or Checkpoint line? Of course, if you are one of those rare and mysterious creatures
whom we respectively call "Excel gurus", you can try to make such a graph on your own, with the
help of this article: Advanced Gantt Charts in Microsoft Excel.

However, a faster and more stress-free way would be using an Excel Gantt chart template. Below
you will �nd a quick overview of several project management Gantt chart templates for di�erent
versions of Microsoft Excel.

Gantt chart template for Excel 2013 and 2016 from Microsoft
This Excel Gantt chart template, called Gantt Project Planner, is purposed to track your project
by di�erent activities such as Plan Start and Actual Start, Plan Duration and Actual Duration as well
as Percent Complete.

In Excel 2013 and 2016, this template is available directly on the File > New tab. If you cannot �nd it
there, you can download it from Microsoft's web-site - Gantt Project Planner template. This

Series from the context menu). 

When you have created an awesome design, it might be a good idea to save your Excel Gantt
chart as a template for future use. To do this, click the chart, switch to the Design tab on the
ribbon and click Save as Template.

https://www.ablebits.com/excel-tutorials-examples/gannt-chart.xlsx
http://peltiertech.com/Excel/Charts/GanttChart.html
http://office.microsoft.com/en-us/templates/gantt-project-planner-TC102887601.aspx
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template requires no learning curve at all, simply click on it and it's ready for use. 

Online Gantt chart template
This is an Interactive Online Gantt Chart Creator from smartsheet.com. As well as the previous Gantt
chart template, this one is fast and easy-to-use. They o�er 30 days free trial, so you can sign with
your Google account here and start making your �rst Excel Gantt diagram online straight away.

The process is very straightforward, you enter your project details in the left-hand table, and as
you type a Gantt Chart is being built in the right-hand part of the screen. 

Gantt chart template for Excel, Google Sheets and OpenO�ce
Calc
Gantt chart template from vertex42.com is a free Gantt chart template that works with Excel 2003,
2007, 2010, 2013 and 2016 as well as OpenO�ce Calc and Google Sheets. You work with this
template in the same fashion as you do with any normal Excel spreadsheet. Simply enter the start
date and duration for each task and de�ne % in the Complete column. To change the range of

https://www.smartsheet.com/s/online-gantt-chart
http://www.vertex42.com/ExcelTemplates/excel-gantt-chart.html
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193 Responses to "How to make a Gantt chart in Excel 2010,
2013 and Excel 2016"
← Older Comments  

dates displayed in the Gantt chart area, slide the scroll bar. 

And �nally, one more Gant chart Excel template for your consideration.

Project Manager Gantt Chart template
Project Manager Gantt Chart from professionalexcel.com is also a free project management Gantt
chart template for Excel that can help track your tasks against their allocated time. You can
choose either the standard weekly view or daily for short term projects.

Hopefully, at least one of the above-mentioned Gantt chart Excel templates is well suited for your
needs. If not, you can �nd plenty more Gantt chart templates on the web.

Now that you are familiar with the main features of the Gantt diagram, you can explore it further
and create your own sophisticated Gantt charts in Excel to amaze your boss and co-workers : )

 Nav says:
December 15, 2016 at 10:34 am

Hi there,

My current gantt is entered in days. How can I change that to re�ect weeks? 
Please respond urgently

Thank you

Reply

 unknown says:
November 14, 2017 at 8:00 am

try exiting in weeks. so it will re�ect the weeks that you have wasted.

Reply

1

 Deanne Bhamgara says:
December 23, 2016 at 4:31 pm

Hi there, 
I have a couple inquires for making a timeline on Microsoft Excel. 
If a project has multiple task that occur at the same time, how should I re�ect it on the gantt
chart? I know its quite easy for me to do it on a smartsheet but how would I do it on excel.

Second question, If I do create the chart on Smart sheet, is there a way I can export it to an
excel sheet format?

Reply

2
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 Nav says:
January 3, 2017 at 6:58 pm

Hi there, 
My current gantt is entered in days. How can I change that to re�ect weeks? 
Please respond urgently 
Thank you

Reply

3

 Pete says:
January 23, 2017 at 8:59 pm

How do I add an additional task once the chart has been completed and in use?

Reply

4

 Leslie says:
January 23, 2017 at 9:45 pm

I just wanted to say thank you for such a fabulous and easy to use tutorial. In my 12 years as
a legal assistant, I've never been asked to create a Gantt chart until today, and I impressed
my boss! Thanks for helping me not look like an idiot...because let's get real, I didn't even
know what this was until today!

Reply
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 russeladrian says:
January 26, 2017 at 6:27 am

how about in tablet or phone how to combine the task?

Reply
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 Dimitri says:
January 29, 2017 at 12:21 am

Thank you for the support, this was very helpful

Reply

7

 Azim says:
January 31, 2017 at 4:25 pm

Thank you! It was very useful

Reply

8

 Julius says:
February 7, 2017 at 2:35 pm

Adding more task didn't a�ect the chart. how's it done? thanks

Reply

9

 Hannah says:
February 18, 2017 at 12:19 am

Repeat of a question asked several times above but not answered--is there a way I can make
this work for repeated tasks? The above steps work well for linear tasks, but let's say I need
'documentation' to appear every 60 days in my chart, ie I have more than one start and end
dates for a single line item. How do I re�ect that?

Reply

10

 Tony says:
February 19, 2017 at 6:25 pm

Thank you for this posting - You just saved me. 
I needed a quick �x to not having MS Project in a rush situation. 
Much appreciated.

Reply

11

 Darcy Dredge says:
February 21, 2017 at 5:54 pm
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When I copied my text for my task list on my gantt chart, it looks to be automatically right
justi�ed. Is there a way to left justify this text on the gantt chart?

Thank you

Reply

 fawad says:
March 2, 2017 at 6:34 am

GOOD DAY 
Is there a way to edit Gantt chart planner in Excel like I want completed task percentage bar
to look green but in excel planner its purple in color so I want it to look green.

Reply

13

 Swapnali says:
March 16, 2017 at 7:12 am

Chart is not take actual date on X-Axis. Kindly help to take the actual date.

Reply

14

 1210 says:
March 23, 2017 at 3:01 am

Thank you very much. Your explanations were very helpful I was able to create my �rst Gantt
Chart on my very �rst try. :)

Reply
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 Nambitha says:
March 23, 2017 at 8:17 am

I need to do a Grantt cash and C-�ow?

Reply

16

 Lorraine Ramaphala says:
March 23, 2017 at 10:35 am

THANK YOU

Reply
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 Martin says:
March 29, 2017 at 10:55 am

Anyone know how to make my tasks name appear in full within the gantt chart?

Reply

 Tannglynn Browne says:
March 29, 2017 at 2:21 pm

Not sure if this is what you mean, but to make the column bigger to �t the words you can
slide your mouse to the lines separating the rows. Once you do that your on-screen mouse
will change to the four arrows and you can pull your column outwards by moving the
mouse or your �nger if you're on a touch screen device

Reply

 Natalia Sharashova (Ablebits.com Team) says:
April 13, 2017 at 2:33 pm

Try this detailed tutorial, it's super easy!

Reply
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 Tannglynn Browne says:
March 29, 2017 at 2:16 pm

I'm not sure if someone else has already asked this, but does anyone know how to write the
start/end dates properly? Whenever I type down 31-Jan-17 it automatically changes to
31/01/17.how do I stop this?

Reply

19

https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/?replytocom=226430#respond
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/comment-page-2/#comment-227272
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/?replytocom=227272#respond
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/comment-page-2/#comment-237902
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/?replytocom=237902#respond
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/comment-page-2/#comment-245528
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/?replytocom=245528#respond
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/comment-page-2/#comment-245578
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/?replytocom=245578#respond
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/comment-page-2/#comment-245612
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/?replytocom=245612#respond
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/comment-page-2/#comment-251603
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/?replytocom=251603#respond
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/comment-page-2/#comment-251882
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/?replytocom=251882#respond
http://www.ablebits.com/
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/comment-page-2/#comment-270182
https://support.office.com/en-us/article/Show-task-names-next-to-Gantt-chart-bars-46cf45ad-cfd9-4427-9aa0-b4586e22ead8
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/?replytocom=270182#respond
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/comment-page-2/#comment-251879
https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/?replytocom=251879#respond


12/4/2017 How to make Gantt chart in Excel (step-by-step guidance and templates)

https://www.ablebits.com/office-addins-blog/2014/05/23/make-gantt-chart-excel/ 17/21

 Svetlana Cheusheva says:
March 30, 2017 at 8:33 am

Hello Tannglynn,

When you type a date in a cell, Excel automatically converts it to the default date format. To
display dates in your own format, do the following:

- Select the cells where you want to enter (or have entered) the dates and press Ctrl+1 to
open the Format Cells dialog. 
- On the Number tab, and select Date in the Category list. 
- Under Type, pick a desired date format, and click OK.

For more information, please see How to change date format in Excel.

Reply

 Jose says:
April 6, 2017 at 4:34 pm

Thank you so much, Svetlana! This short tutorial and the resources listed at the end are
fantastic!

Reply

20

 Jamie says:
April 17, 2017 at 5:19 pm

Hi There, How do I extend dates past the dates given on the template? For example, if I want
a project to go into July, i can't get the blue bar to re�ect into July even when I duplicate the
week number, day, etc...

Thank you,

Reply
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 Emma says:
April 24, 2017 at 3:24 pm

Svetlana, I cannot tell you how helpful this is. Thank you very much for this fantastic
document.

Reply
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 Ian Cardin says:
April 28, 2017 at 2:15 pm

Hi Svetlana,

Just stumbled across this article while trying to create a Gantt chart in Excel. This was
extremely helpful, straightforward, and useful. Thank you so very much for writing it =) =)

Reply
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 LUCILLE says:
May 3, 2017 at 11:14 am

THANKS A MIL FOR THE STEP BY STEP. I COULD DO IT MYSELF EVEN THOUGH IM NOT A PRO
IN THE AREA. :)
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 Harrison Del�no says:
May 5, 2017 at 1:59 pm

I had been using MarketXLS for this and it's great.

Reply

25

 Tanya says:
May 13, 2017 at 4:01 pm

Hi there,

Thank you so much for the tutorial. I have followed all the steps and everything seems to
work �ne but my x-axis comes up with 'bounds' instead of the dates and I was wondering if
you knew how to �x this? I'm using excel 2017 for mac.

Thank you so much!!
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Reply

 Edmond says:
May 23, 2017 at 9:47 am

Thank you so much for the much needed information! Very helpful indeed in my journey of
seeing things in another perspective. More power and God Bless!

Reply
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 Simon says:
May 26, 2017 at 9:36 am

Thank you.. you are saving me time at work by helping me keep the boss paci�ed.. which
means I can get home and spend more time with my wife. 
Plus it's sunny outside today.. who wants to spend more time in the o�ce?

Reply
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 Nicholas Midiwo says:
May 31, 2017 at 5:46 am

A warm thank you for all your help, guidance and support through these easy to follow steps. 
It was very easy to follow and the �nal output was just as I expected. 
Thanks and know we appreciate the e�ort you took to prepare this tutorial.

Reply
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 Mike says:
May 31, 2017 at 7:27 pm

You have made it easy to create a great looking chart, that I probably could not have �gured
out myself. Thank you so much!
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 Vince says:
June 1, 2017 at 2:55 am

Any chance we can modify the color/legend of gantt chart template from MS ?
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 Glenn says:
June 6, 2017 at 2:16 am

How do you name your chart inside the GANTT chart?
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 Tareq Sasila says:
June 11, 2017 at 1:25 pm

That's was Great
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 Avishek Majumder says:
June 16, 2017 at 5:17 am

It has truly been a help in creating Gantt Chart. Great and clear instructions.

Reply
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 tezi lesly says:
June 21, 2017 at 5:18 pm

i really enjoy the program. 
Please include me in the group, really to expound my knowledge on gantt charts especially
conditional formatting
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 Ryan says:
July 5, 2017 at 6:59 pm

Excellent tutorial! Thank you.
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Reply

 Frieze says:
July 11, 2017 at 8:34 pm

Great and clear tutorial, thank you.

Reply
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 Tasha says:
July 13, 2017 at 7:07 am

Very helpful - thank you!
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 Jawad says:
July 22, 2017 at 9:33 pm

Excellent! 
It was very helpful. Thanks.
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 Cyrus says:
July 24, 2017 at 3:32 pm

What an incredible guide, thank you!

In the �rst technique described in post, would it be possible to create conditional formatting
so the colors of the task are tied to the assigned "champion"?

For example, say Gather Requirement and UI Design will be championed by "Bob" and the
rest of the tasks by "Billy". Is it possible to automatically assign "Bob" orange and "Billy" blue
so it is clear who's doing what?
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 Mustafa says:
July 29, 2017 at 4:45 pm

Just wanted to say thank you! this was excellent!
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 Lizzie says:
July 31, 2017 at 1:14 pm

This is brilliant and so helpful. Good work, thanks
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 Lizzie says:
July 31, 2017 at 1:24 pm

This guide is brilliant, well written, the step by step makes it easy to follow. 
Excellent work, keep them coming. 
Thanks!!!
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 Ajit says:
August 8, 2017 at 11:59 am

Thank You! This is very helpful. You saved my day long work.. :)
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 Aditya Garg says:
September 2, 2017 at 3:04 am

Thank you so much for this article.
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 Glenda Carl says:
September 6, 2017 at 10:48 pm
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Thank you so much for this exceptionally clear and helpful tutorial! I (still) have O�ce 2011
for Mac, and it was easy to follow your instructions and make a chart that looked exactly the
way I want.
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 Marie says:
September 13, 2017 at 5:21 am

I can't change the date

Reply
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 Ken says:
September 14, 2017 at 3:44 am

Thanks to your excellent, easy to follow article, I was able to create a Gantt chart that met
most of my requirements. However, I cannot get it to display more than 8 tasks even though I
have more than that in my table. I have played around with the Gap Width and Series Overlap
values but it doesn't make any di�erence. Is here a setting that governs the number of bars
you can display?

I am using Excel 2016 in the O�ce 365 Pro Plus suite.
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 Ryan says:
September 18, 2017 at 4:32 pm

very helpful thanks
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 Andree Dillon says:
September 21, 2017 at 5:56 pm

Hi there - this is great, thanks! Is it possible to omit weekend (saturday and sunday) from
being part of the duration?
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 xyetzo says:
October 14, 2017 at 1:16 am

really help even it simple. but ya..we got the main point
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 Npmpumelelo says:
October 29, 2017 at 3:46 pm

Thank you so much this has been so helpful.
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 Remi says:
November 1, 2017 at 6:23 pm

Great explanation, very useful feature, already rolled out to my team 
thank you very much
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 Sally says:
November 2, 2017 at 9:58 pm

Awesome article! very helpful.
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 Chong Yen Ping says:
November 5, 2017 at 5:01 am

Any templates for Ghatt chart
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← Older Comments  

Post a comment
Name  Name

name@example.com  E-mail (not published)

Send   

Unfortunately, due to the volume of comments received we cannot guarantee that we will be
able to give you a timely response. When posting a question, please be very clear and concise.
We thank you for understanding!

 Anton Croos says:
November 10, 2017 at 3:17 pm

No words to thank you... simply thank you for sharing your knowledge. You people make this
earth more beautiful. Thank You So Much.

Reply
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 Vabz says:
November 20, 2017 at 1:42 pm

Hello everyone,

Why this chart is starting from Jan 11? Here also the earliest activity start date is Mar 1, 2014. I
followed the same steps and my �rst start date is Nov 27 but on my chart's date axis all
activities are starting from Nov 11.

Please explain and tell me what I am doing wrong.

Thanks and Regards 
Vabz

Reply

 Svetlana Cheusheva says:
November 20, 2017 at 4:36 pm

Hello Vabz,

Blue bars starting from Jan 11 were only an intermediate result. On step 5, we make them
disappear so that only orange bars are visible (the earliest activity start date is Apr 1). To
improve your Gantt chart further, please follow the instructions from step 6 that explain
how to remove the empty space on the left side of the chart. The result is shown in the
screenshot at the end of step 6 (the date axis beginning with Apr 1).
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 emris says:
November 30, 2017 at 4:23 pm

was really helpful

Reply
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